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Letter from the President

Greetings All,

Spring seems to be under way at last!  Suddenly many things to do for ourselves and as Master 
Gardeners; gardening plans, new plants to try, and plenty of opportunity for learning and fun.

News from the May 27 Board meeting includes Bruce MacNeil being tentatively appointed as 
Zone 4 Director.  The new budget with revised expectations of revenue has been approved.  The 
addition of an educational component will be pursued for the next AGM.  I will be sending out a 
more detailed report to the group Coordinators.

We have had a lot of rain this year in southern Ontario, and we will likely be looking for some 
come summer, but so far a really good jump on the season in the garden. Lots of things growing 
by inches every day.   Have a great gardening season this year!

Crystal Trojek
President, MGOI

From the Editor -  The name, What's Growing On?, was suggested by a Simcoe County MGiT and 
endorsed by other MGOI members subscribed to the MG-List.  I hope the rest of you will be happy with 
the choice. 

+ In Memoriam

Neil Thomas' strong presence will be remembered in the Ontario Master Gardeners' association.  He had a booming 
authoritative voice which many were introduced to when he emceed the annual Ontario Master Gardener conferences. 
Neil  passed away on February 23, 1997, on his 59th birthday.  I think he epitomized what Master Gardeners is all 
about.  Remembrances of Neil by Sandy Ellenor can be found under Windsor-Essex Master Gardeners.

MG-List
 
The reason for establishing the MG-List was to increase communication between Master 
Gardeners and their groups.  When subscribed to the List, you will see all messages posted.  If you 
have gardening questions which you cannot answer, and do not have the research facilities 
available to find an answer, field that question to a larger audience.  Let everyone know about the 
special events or fundraisers that your group is sponsoring.  Sharing of information helps us grow.  
We are interested in hearing about your speakers, your meeting format, etc.; perhaps, there could 
be a submission from each group after monthly meetings.   If you hear of any new great gardening 
products, seminars, or new plants, let everyone know.  Encourage all Master Gardeners you know 



with email access to subscribe.  If you don't have a personal computer; you can set up a personal 
email address through one of the internet sites such as www.netscape.com or   www.hotmail.com; 
ask at your local library for instructions.  Once you have your email address, subscribe to the MG-
List:   Email majordomo@eagle.ca  and in the body of the email, put the following:  subscribe mg-
list.  (no period)  Make sure your email format is in Plain Text so that the request is received 
correctly.  When emailing to the List, use Plain Text so that everyone can read it.

North, South, East, and West

Algoma, Brantford, Brooklin, Burlington, Dundas, Dunnville-Haldimand, Elgin County, Gananoque, Geraldton, 
Grey, Guelph-Wellington, Huron, Kitchener, Lake Simcoe South, Lanark County, Lindsay, London-Middlesex, 
Mississauga, Muskoka-Parry Sound, Niagara, North Bay, North Bruce, Ottawa-Carleton, Oxford, Peterborough, 
Prince Edward County, Quinte-Tweed, Rainy River District, Renfrew County, Sarnia-Lambton, Simcoe County, 
South Bruce, Stratford, Sudbury, Temiskaming, Thunder Bay, Toronto, and Windsor-Essex.

Across Ontario, there are 38 Master Gardener groups, including the satellite group of Thunder Bay, 
Geraldton.  This issue highlights the activities of two of these groups.

Windsor-Essex (Growing Zone 7a)
by Sandy Ellenor

Neil Thomas was a broadcaster, a journalist, and a Master Gardener. He had lived in many parts of 
the world, but his time with Master Gardeners was very special.

Neil started up the Plant a Row program in Windsor in 1994 after learning of the idea from Jim 
Wilson of the Victory Garden who was in the area for the International Master Gardener 
Conference held in Detroit; Neil had the job of chauffeuring Jim around to local tv and radio 
stations for interviews, etc.   To quote Neil, " The beauty of this campaign is that it involves no 
overhead to administer, no full time employees to take care of it and no funding from any agency 
other than the gardeners themselves."  In one of Neil's articles, he had some stories about stuff 
brought in; for example, how acid free tomatoes were such a hit because many people down on 
their luck develop ulcers-- who would think of that?  Some people thought they have so little to 
offer, why bother?  He told us that just 3 cucumbers would go to 3 families; I remember once he 
told us that people sometimes would bring in a few extra flowers and how that could cheer 
someone down on their luck; some people even took in an extra jar of home made jam.  To those 
that said some of these people were too lazy to grow a garden, which could be the case in a small 
percentage, his response was think of the children who need the fresh produce in their growing 
years and who have no control over their situation.  The last few years, the Hort students at St. 
Clair College start the tomato plants from seed.  This year we are going into the schools to help 
kids plant seeds too.  A committee, including Karen Batke, our Coordinator, along with the 
Unemployed Help Centre and the radio station works on the project; this year we will be handing 
out kits that will include donated seeds, fertilizer, hats, key chains, magnets, and recipes, as well as 
a 4 pack of tomatoes May 6 and 7.   The food is distributed to 19 area food banks.

In his gardening, Neil was beginning to seek out alternative means to chemicals; he was a hit with 
the Borax recipe for killing Creeping Charlie.  He always said he had a natural dislike of lawns, 
saying in one article, "I will once again urge people to tear out their lawns and put in some real 
plants for a change.  Lawns are the greatest consumer of water, fertilizer, herbicides, pesticides and 
fungicides of any kind of landscaping.  They also seem to occupy the greatest amount of time and 



concern of any garden feature among too many people.  And for what ?  A blank green space 
which could be achieved by laying Astroturf or painted concrete. The same time and effort put into 
developing beds of annuals, perennials, shrubs and small trees will give you a much healthier 
environ-ment and relieve a lot of tension you feel when your lawn is less than perfect, particularly 
when I tell you no lawn is perfect.  It would probably be cheaper and easier to get that same 
expanse of green by sewing together $20 bills and carpeting your lawn with that."  Don't you love 
those quotes?  My, how this has reminded me how much I really miss him.  He had been such an 
inspiration.  What a loss to the community and Master Gardeners!

Dundas (Growing Zones 4 - 5)
by Nancy Jordan

From Vankleeek Hill, Cornwall, Morrisburg, Iroquois, Metcalfe, Morewood, Chesterville and 
Winchester.  We meet monthly, except in July, in Winchester, the half-way point, some members 
having to drive 40 - 60 km to get to the meetings.  A small group of 11, we're hoping to grow.  
Every year we have at least one plant sale to raise funds for our speakers, new books for our 
library and for our aprons and T-shirts.  We also volunteer at the yearly Upper Canada Heritage 
Plant Sale, judge gardening contests, speak to various horticultural groups, judge and speak at the 
different fairs around the area, have a booth at the Agricultural Day for grade 3 students, and  
speak to seniors' groups.  This year we will be providing gardening advice and help in the garden 
of a Senior's Support Centre in Winchester and will enjoy a free meeting room once a month in the 
process.  They are very excited to have us as a part of their centre, and we were glad to have a new 
meeting facility--an extremely nice one too!

We  have one social event in the summer and a gift and baking exchange party at Christmas.  
Every year we try to take a tour of an interesting garden or garden centre; and we have several 
very interesting speakers; this year a fruit grower who trained in Italy speaking on grafting; and an 
area garden centre owner speaking on gardening trends for the 2000's.

Internet Sites

MGOI Web Page
By Ted Reed, North Bay

The MG Home Page is at: www.interlog.com/~onthort/mg/mg.html
MG groups who have an existing web page on the internet, not listed below, please send me your 
URL and any other general information you wish to add.  If you don't have a home page, send 
information as an attached .HTM file, and it will be added  to the MGOI  home page.  Questions 
about home pages, contact Ted Reed at tedreed@onlink.net

Group Web Sites

North Bay - www.interlog.com/~onthort/dist18/callande/mastergd.html
London-Middlesex - www.execulink.com/~wilson1/MG/main.htm
Sarnia-Lambton - www.sarnia.com/mastergardeners 
Guelph-Wellington - http://ntserv1.chembio.uoguelph.ca/mastergardener/ 
Brantford - http://www.bfree.on.ca/comdir/alh/gdmaster/test.htm 

Gardening Tutorials www.etera.com/school/TutorialCreator/view/tutorialdefault.asp



Lots of Resources
www.virtualgarden.com
Time-Life Plant Encyclopedia, how-to, locate your zone, botanic gardens, forums, FAQ's, etc.

MG Comments

The membership fee and fundraising by Bruce MacNeil, Kitchener-Waterloo 
What do we get for our $12 membership fee?  It goes towards the administration of  MGOI 
including the Administrator's salary; insurance; materials for the groups including MGOI Resource 
Book, name tags, and certificates; board meetings including the AGM; Annual Report; Auditors 
fees; and newsletter.  Editor's Note:  The groups have been asked this year to assume the 
responsibility of newsletter distribution to their members.

The 2000 Budget included fund raising of $11,000 but this amount was reduced by $6,000 at the 
AGM. This means that
expenditures will have to be reduced by $6,000 leaving us with $5,000 to
raise towards expenses.

It is generally agreed that individual groups may find it easier to raise funds than MGOI as most 
funding agencies, e.g., Loblaws, Landscape Ontario, White Rose, etc. are looking for return on 
their money; i.e., the use of our expertise.  I think we can raise the $5,000, with the help of each 
group.  Chris Graham of RBG also offered help in the form of advice from RBG's fundraiser.

Lorraine Holding  (OMAFRA), a strong supporter of the Ontario Master Gardeners, is retiring this 
year and as a result will be stepping down from the MGOI Board.  She  suggested that if 30 
Master Gardener groups could come up with $200 each for MGOI, in addition to our fees, we 
would have $6,000 towards the year's income. The Board of Directors would like to express their 
sincere appreciation and thanks for donations from the following groups:  Guelph-Wellington; 
Kitchener; Lake Simcoe South; Niagara; North Bay; and Simcoe County.  I'd like to challenge all 
groups to do likewise or to help in whatever way they can.

Should the Master Gardener Groups be funding MGOI? by Stewart McCombie
No – in the long term they should not.  MGOI should be providing funds to the Groups.

Over the past two years I have convinced three government ministries that MGOI’s purposes are 
charitable.  It exists to "advance the horticultural knowledge of the home gardener and of the 
general public in Ontario by carrying out such activities as conducting seminars and workshops, 
providing gardening information via the media and telephones, information sessions at malls, 
fairs, etc., and advancing therapeutic benefits of horticulture among long-term hospital patients 
and seniors in senior’s homes, etc."
These activities can only be carried out by the Groups who make up MGOI.  Charitable funds 
raised by MGOI must go to these activities and therefore must go to the Groups.  When the Master 
Gardener program was under the care of OMAFRA, new Master Gardeners were provided with 
course material at no cost to them.  Groups received funding toward update clinics annually.  New 
Groups received a collection of reference books and assistance with funding.  These, in my 
opinion, should be some of the goals of MGOI.  These are things that would help forward the 



goals of the organization.  There are others.  These things cannot be accomplished instantly.  
MGOI just had its second birthday in March.  Its charitable status was just obtained in February of 
this year.  Now is the time for us all to work as a unit to make these things happen; not as 38 
Groups or even 8 zones.  Should the individual members be willing to pay a membership fee to 
belong to MGOI?  It certainly seems reasonable to me.

The Asian Longhorned Beetle
by Elma Vanags, Gananoque

Welcomed by Kingston Mayor Gary Bennett and introduced by our flamboyant Town 
Crier, Dr. David Roden, Research Scientist at Canadian Forest Service, delivered a timely and 
interesting talk about the Asian Long-horned beetle (ALB), a stow-a-way from China.  ALB kills 
healthy hardwood trees.  The only control method today is quarantine and cutting and burning of 
infested trees.   In a quarantined laboratory at Sault Ste. Marie, David is researching methods to 
control ALB.  He felt biological control could be the most promising method.  Initial field tests by 
US Department of Agriculture in which Imidacloprid (Merit) was injected in the soil at the base of 
the tree, were disappointing.
About 200 people listened attentively; many asked probing questions.   ALB and look-alike 
specimens at various life stages, as well as damaged wood samples brought by Dr. Roden and 
members of Canadian Food Inspection Agency created a lot of interest.

The Master Gardener Public Information project to raise public awareness of ALB was a 
resounding success.  The project required several months of intensive work mainly by the Project 
Committee.  We recommend ALB as a subject for Technical Update.  For more information 
contact Dorothy Elston, Chair Public Information Project at 613-544-8880 or elston@kos.net.

Gardening for Kids (from the MG-List) 

LifeSpin (from the MG-List) -  LifeSpin, of London, Ontario, has produced the "Pocket-Sized Farms 
Kid's Garden Book".  Organized around the seasons the book is designed for children to use as 
members of a school garden club or in their own backyards.  The book uses a Crow and a scare-
crow, in a rhyming story format to guide children through a series of important organic gardening 
principles.  It is intended both as a source of inspiration and a learning opportunity.  The book 
includes a number of journal pages to make garden notes as well as space for kids to design their 
own garden plan.

The book is part of a package of materials that LifeSpin is developing to encourage London area 
schools to develop productive, inspiring gardens on currently barren school yards.  We believe 
these spaces can be a source of healthy, organic food.  The second part is a Teacher's and Parent's 
Guide to Organic Gardening that will be available soon.  This will include organic gardening 
advice, a number of educational activities, and specific tips for gardening with young kids.

The Kid's workbook - Pocket-Sized Farms sells for $10 each or $8.50 each for five or more 
copies.  The "Teacher's and Parent's Guide to Organic Gardening" will sell for $15 each.  Call Rob 
Barrs at LifeSpin (519) 438 8676 ext.31 to order copies.



Hostas?   www.hostalibrary.org

Did you Know?

Thunder Bay Master Gardeners with the T.B. Art Gallery are planning a "Millenium Tour", June 3,  
featuring four gardens with  different educational themes.  Lecture and demonstration included.  $20 (100 
available)  Contact  Ralph Bullough at 807-767-2331.

Peterborough Master Gardeners, will hold a Millennium Garden Tour, June 25,  10- 5, with 4 city and 
2 country gardens covering a wide variety of garden styles and environments. Informative talks and 
demonstrations plus garden items for sale.  $10.  Contact Rachel Burrows,    705-799-2065.

Simcoe County Master Gardeners present  A WALK AROUND THE GARDEN, 4 seminars,   Sundays 
in June and July. June 4, 2 - 4 p.m., "Eclectic by Nature!"  A country garden with a bit of everything…
Learn what grows well in sun or shade, dry or wet areas. June 18, 2 - 4 p.m.., "A Naturalist's Delight"  
indigenous flowers …marsh marigolds, irises, roses and vegetables.  Plants for sun and shade.  July 9, 9 
a.m. - 11 a.m..  "Work in progress!" …over 12 gardens including a rock garden, children’s garden, mixed 
borders and island bed.  July 30, 10 a.m. - 12 noon and 2 - 4 p.m.  "Established Garden by the Lake"   
Many years of innovative gardening has produced this lovely garden by the lake. Learn how to build a rock 
garden, cascading stream, lily pond, rose garden, modified Japanese garden, lathe house, solarium, 
perennial garden, containers, raised bed square foot vegetable garden, plus pruning instructions.  $10. per 
person per seminar.  Each Seminar limited to 25 persons. Contact Jane Blackstock, 705-721-0483. 

Plant Identification

Sorbus thuringiaca, a Mountain Ash you wouldn't expect.  Check out the non-pinnate species in a good 
reference book or the picture at http://herba.msu.ru/pictures/Living_pictures/lp_061.jpg 

Computer Info - Claire Therrien, Sarnia-Lambton, provides the following tips on using HTML 
formatting:  When you create messages using HTML formatting, only mail programs that support HTML 
can read the formatting.  If the recipient's mail or program does not read HTML, the message is displayed 
as plain text with an HTML file attached.  To use HTML formatting on all outgoing messages:  In the main 
window, click the Tools menu, click Options, and then click the Send tab.  In the Mail Sending Format, 
click HTML.  To use HTML formatting on an individual message:  In an email message window, make sure 
HTML formatting is turned on by clicking the Format menu.  HTML formatting is turned on when a black 
dot appears by Rich Text (HTML).   Notes:  To edit the HTML source tags, click the View menu and make 
sure a check mark appears next to Source Edit.  Then, select the Source tab and start editing.  To set up 
Outlook Express so that your message replies are sent in a format that the originator's mail program can 
read, in the main window, click the Tools menu, click Options, and then click the Send tab.  Check the 
Reply to messages using the format in which they were sent check box.

U.S. Northwest MG Conference
www.wvu.edu/~agexten/mgconf.htm 

Book Review

Great Garden Companions.  A Companion-Planting System for a Beautiful, Chemical-Free Vegetable 
Garden, S. J. Cunningham, Rodale Press, Inc., Emmaus, PA, 1998. 278 pp
Reviewed by Shirley Bellows, London-Middlesex

The book that I would have liked to have written!  The author describes and recommends so many things 
that I have been doing successfully in my garden. Cunningham, a Master Gardener, manages the Consumer 
Horticulture and Master Gardener programs at Cornell Cooperative Extension.  She has a weekly television 
appearance on Channel 4, WIVB-TV in Buffalo, where she gives information and answers call-in 



questions.  In her garden at Wonderland Farm she puts into practice everything she recommends.

This well-illustrated book gives much more information than the title implies.  The 'companion' part refers 
not only to what plant grows best near another but how to attract other friends into the garden.  Chapter 5, 
'Bringing in the Good Guys' is an excellent reference guide on beneficial insects including how to attract 
them and how to keep them in your garden.  In addition, there is a further 10 pages of charts of  'Plants for 
Beneficial Insects' near the back of the book.  Organic gardening practices are explained thoroughly.  There 
is an instructional section on vegetable crops with a one to two page explanation of her growing methods 
on each vegetable plus informative 'Sally's Tips & Tricks' captions. 

Initially, I borrowed this book from the public library but liked it so much that I purchased it.  It is a 
reference guide for organic gardening that will be kept near at hand.

Tufa Containers:  equal parts  perlite,  peat, and Portland cement. Another recipe: Mix Portland cement, sand and 
sieved peat in proportions of 1-2-1/2. Add water until it is moist but not runny. Cover the container mold with plastic.  
Wearing gloves, press handfuls of the mixture on to the container mold until the top part is covered. Let dry for a few 
days.
Leave for about a week and brush with a wire brush. If big pieces fall off, reapply the tufa. When well dried, you can 
paint the surface with live yogurt to encourage the growth of lichen and moss. A summer project; frost affects the 
hardening process.

Crossword

by Sandy Ellenor, Windsor-Essex
Down
1 tubers, container or hanging plant (7)
3 classes incl. pompom, decorative and cactus (6)
4 harbinger of spring (6)

Across
2 Foxtail Lily (8)
4 mass plantings, tall, tropical appearance (5)
5 ear of a jungle (4)
6 orange flowers, pot plant (6)
7 wild hyacinth (8)


